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ARGOPd est constitué de modules de

synthèse et de traitement sonore et visuel

fonctionnant en temps réel sous Pure Data.

Pour MacOSX, Linux, Windows.

ARGOPd est un logiciel libre et ouvert.

ARGOPd est conçu pour des utilisateurs

qui n'ont jamais programmé Pure Data

ARGOPd is made of real-time sound

and visual synthesis modules.

A module is a Pure Data patch.

For MacOSX, Linux, Windows.

ARGOPd is an OpenSource freeware.

ARGOPd is conceived for users who

have never programmed Pure Data

sous licence / under license "Creative Commons"

http://gerard.paresys.free.fr/ARGOPd/

http://pagesperso-orange.fr/Paresys/ARGOPd/

http://gerard.paresys.free.fr/ARGOPd/
http://pagesperso-orange.fr/Paresys/ARGOPd/


ARGOPd exige l'installation

de Pd-0.41.4-extended minimum.

Pd-0.41.4-extended est une

version étendue de Pure Data (Pd).

http://fr.wikipedia.org/wiki/Pure_Data

Pd est un logiciel libre.

Pd existe pour MacOSX, Linux, Windows.

3 Télécharger ARGOPdv05.zip

   depuis l'adresse: 

4 "Dézipper" le fichier ARGOPdv05.zip

3 Download ARGOPdv05.zip

   from:

4 "Unzip" the file ARGOPdv05.zip

5 Le dossier “ARGOPdv05” contient

    - un dossier “MM”: tous les MiniModules

    - un dossier “ExMM”: exemples

    - un dossier “Ancien-Ancient”:

                       ArgoPdv04...

5 The folder "ARGOPdv05" contains

    - a folder “MM”: all the MiniModules

    - a folder “ExMM”: Examples

    - a folder “Ancien-Ancient”:

                  ARGOPdv04...

http://puredata.info/downloads

Installation

ARGOPd requires the installation

of Pd-0.41.4-extended mini.

Pd-0.41.4-extended is an

extended version of Pure Data (Pd).

http://en.wikipedia.org/wiki/Pure_Data

Pd is free software.

Pd exist for MacOSX, Linux, Windows.

1 Télécharger Pd-0.41.4-extended

   depuis l'adresse: 

1 Download Pd-0.41.4-extended

   from:

http://gerard.paresys.free.fr/ARGOPd/

http://pagesperso-orange.fr/Paresys/ARGOPd/

Pour les connaisseurs:

Un MiniModule (MM) est un

"Graph-on-parent subpatch".

Un "ExMM" est un "patch" constitué

de plusieurs MM connectés.

Dans “Ancien---Ancient”

les modules de ARGOPdv04

sont des patches. 

For the experts:

A MiniModule (MM) is a

"Graph-on-parent subpatch".

An "ExMM" is a "patch" consists

of several connected MM.

In “Old---Ancient”

the modules of ARGOPdvO4

are patches.

2 Installer Pd-0.41.4-extended 2 Install Pd-0.41.4-extended

ou / or
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Lancer l’application Pure Data

Ouvrir le dossier ARGOPdvO5

Ouvrir le dossier MM

Ouvrir All-ARGOPdMM.pd

Un fichier Pure data a l’extension .pd

Attention: sous Linux ou Windows: ne pas

ouvrir par 2 x clic sur un fichier .pd

mais en faisant Menu File puis Open.

Sinon une nouvelle instance de Pure data

est lancée à chaque ouverture.

Début / Beginning

Launch Pure Data application

Open ARGOPdv05 folder

Open MM folder

Open All-ARGOPdMM.pd

A Pure Data file has the extension .pd

Caution: under Linux or Windows:

do not open by 2 x click a .pd file

but by Menu File then Open.

Otherwise a new instance of Pure data

opens each time.

Cette fenêtre (un “patch” Pure Data)

est une palette qui rassemble

tous les “MiniModules”.

This window (a Pure Data "patch")

is a palette that gathers

all the "MiniModules”.
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Passer en mode Edit:

   (ou Ctrl E ou Pomme E sous MacOS)

                            Copier -> 

Fermer la fenêtre

Coller dans la fenêtre Untitled-1

L’autre mode est le mode Run

On y revient de la même manière

A first Audio patch.

Menu File -> New

All-ARGOPdMM.pd -> Click ->

Menu Edit -> Edit mode

Un premier patch Audio.

Go to the Edit mode:

 (or Ctrl E or Apple E under MacOS)

<- Copy                

Close the Window

Paste in the window Untitled-1

The other mode is the mode Run

Same way to go.
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<- Mouse cursor

<- Click <- All-ARGOPdMM.pd

<- Copy <- Mode Edit

Close the window

Paste in Untitled-1 window

<- Click <- All-ARGOPdMM.pd

<- Copy <- Mode Edit

Close the window

Paste in Untitled-1 window

<- Click <- All-ARGOPdMM.pd

<- Copy <- Mode Edit

(Warning: take the 2 elements)

Close the window

Paste in Untitled-1 window

<- We obtain

You can change the position

of the 4 elements ...

Curseur de la souris ->

All-ARGOPdMM.pd -> Clic -> 

Passer en mode Edit -> Copier -> 

Fermer la fenêtre

Coller dans la fenetre Untitled-1

All-ARGOPdMM.pd -> Clic -> 

Passer en mode Edit -> Copier -> 

Fermer la fenêtre

Coller dans la fenêtre Untitled-1

All-ARGOPdMM.pd -> Clic -> 

Passer en mode Edit -> Copier ->

(Attention, prendre les 2 éléments) 

Fermer la fenêtre

Coller dans la fenetre Untitled-1

On obtient ->

On peut changer la position

des 4 éléments...

Mode Run ->

 Mode Edit ->
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<- The Audio inputs and outputs

 <- The inputs are on top

<- The outputs are on bottom

In Edit mode
Move the MiniModules

 <- Connect the outputs to the inputs

       <- we obtain

Quit the Edit mode

<- Click                                      

We hear a triangular signal
of frequency 440 Hz

of level 0 dB

  Save the patch:
Ctrl S (or Apple MacOS S)
For example “Patch1.pd”

  WARNING:
The extension of the filename

should be .pd

Adjust the frequency
Adjust the level

Les entrées et sorties Audio -> 

Les entrées sont en haut ->

   Les sorties sont en bas ->

En mode Edit
Déplacer les MiniModules

Relier les sorties aux entrées ->

on obtient ->

Quitter le mode Edit:

                                              Clic ->

On entends un signal triangulaire
de  fréquence 440 Hz
de niveau 0 dB

Sauver le patch:
  Ctrl S (ou pomme S sous MacOS)
  Par exemple “Patch1.pd”
  ATTENTION:
    L’extension du nom du fichier
    doit être .pd

Régler la fréquence
Régler le niveau
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<- Adjust the frequency
of the oscillator

Régler la fréquence ->
de l’oscillateur

Régler le niveau ->
de l’amplificateur

<- Adjust the level
of the amplifier

ATTENTION: certains curseurs ne bougent
pas quand le patch est Off

6 méthodes pour régler la fréquence
de l’oscillateur:
  - Glisser le curseur
  - Glisser le curseur en
     maintenant la touche Majuscule
     du clavier pour régler finement
  - Glisser la souris sur le nombre
  - Glisser la souris sur le nombre en
     maintenant la touche Majuscule
     du clavier pour régler finement
  - Clic le nombre + 
     Taper un nouveau nombre au clavier +
     Taper la touche Entrée
  - Entrer un signal dans 

La note (par exemple A3) la plus proche
de la fréquence (par exemple 440 Hz) s’affiche.

WARNING: some sliders do not move
when the patch is Off

6 methods to adjust the frequency
of the oscillator:
  - Drag the slider
  - Drag the cursor while holding
    the Shift key on the keyboard
    to fine tune
- Drag the mouse over the number
- Drag the mouse over the number
  while holding down the Shift keys
  to fine tune
- Click the number
  + Enter a new number on the keyboard
  + Type the Enter key
- Enter a signal

The note (eg A3) closest to
the frequency (eg 440 Hz) is
displayed.
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Audio-Model

Une autre méthode pour construire

un patch Audio est de démarrer

avec un modèle:

Another method to build

an Audio patch is to start

with a model:
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Couleur / Color

Hauteur - Fréquence - Temps Pitch - Frequency - Time

Timbre - Forme Timbre - Shape

Energie EnergyAmplitude

MIDI

OSC

Entrée - Sortie Input - Output

GEM

PDP
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MM-Audio
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MM-Audio

MM-MIDI

MM-OSC

MM-Arduino
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MM-GEM
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MM-PDP



MIDI

MacOSX -> Pd -> Menu Pd-extended ->       

            -> Preferences -> MIDI settings... ->

MacOSX -> Dossier Applications -> Dossier Utilitaires ->

-> Configuration audio et MIDI.app -> Périphériques MIDI ->

-> IAC Driver -> 2 x clic -> Cocher "le périphérique est connecté"

                     -> Ports -> Ajouter un port -> Bus 2

WindowsXP -> Pd -> Menu Media ->       

-> MIDI settings... ->

Linux -> Pd -> Menu Media ->       

-> MIDI settings... ->

ARGOPdManuv05.pdf
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ARGOPdv05 & ARGOPdv04

Dans ARGOPdv05, un "patch" est constitué

de plusieurs MiniModules (MM) connectés.

Dans ARGOPdv04

chaque module est un patch Pure data.

Ces modules sont reliés par

des sortes de cables virtuels:

les ARGOBus et les GEMBus.

Par exemple:

Dans cet exemple, 4 modules,

donc 4 patches sont ouverts.

Les ARGOBus 1 & 2 sont utilisés.

Un module “ARGOGeneral” et un seul

doit etre ouvert (il gere les ARGOBus).

Un patch ARGOPdv05

(constitué de MM reliés entre eux)

peut être relier aux modules ARGOPdv04

grâce à  2 MiniModules:

In ARGOPdv05 a "patch" consists of

several connected MiniModules (MM).

In ARGOPdv04

each module is a Pure data patch.

These modules are connected by

a kind of virtual cables:

the ARGOBus and the GEMBus.

For example:

In this example, 4 modules

therefore 4 patches are open.

The ARGOBus 1 & 2 are used.

A module “ARGOGeneral” and only one

must be open (it manages ARGOBus).

A patch ARGOPdv05

(consisting of connected MM)

can be connected to ARGOPdv04 

modules thanks to 2 MiniModules:

Ex1 (MacOSX)

Wave 1
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Ouvrir - Open

Pour ouvrir un Minimodule:
 - Clic droit sur le MiniModule
   (ou Ctrl + clic sous MacOSX avec une 
    souris à 1 bouton)

 - Un menu s’affiche ->

 - Clic Open ->

 - Clic Pd Help ->

To open a MiniModule:
 - Right click on the MiniModule

   (or Ctrl + click with a one button
mouse on MacOSX)

<- A menu appears

<- Click Open

<- Click Pd Help
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Les exemples ExMM The examples

Le mieux, pour se familiariser avec ARGOPd

est d'ouvrir les "ExMM".

Lancer l’application Pure Data

Ouvrir le dossier ARGOPdvO5

Ouvrir le dossier ExMM

The best thing to do, if you want to get

used to ARGOPd is to open the "ExMM".

Launch Pure Data application

Open ARGOPdv05 folder

Open ExMM folder
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Les exemples ExMM The examples

Le mieux, pour se familiariser avec ARGOPd
est d'ouvrir les "ExMM".

Lancer l’application Pure Data
Ouvrir le dossier ARGOPdvO5
Ouvrir le dossier ExMM
Ouvrir le dossier ExMM11-SampleHold

Un fichier Pure data a l’extension .pd

Attention: sous Linux ou Windows: ne pas
ouvrir par 2 x clic sur un fichier .pd
mais en faisant Menu File puis Open.
Sinon une nouvelle instance de Pure data
est lancée à chaque ouverture.

The best thing to do, if you want to get
used to ARGOPd is to open the "ExMM".

Launch Pure Data application
Open ARGOPdv05 folder
Open ExMM folder
Open ExMM11-SampleHold folder

A Pure Data file has the extension .pd

Caution: under Linux or Windows:
do not open by 2 x click a .pd file
but by Menu File then Open.
Otherwise a new instance of Pure data
opens each time.
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Les exemples ExMM The examples

La pluspart des exemples est sous la forme
d’un dossier contenant plusieurs patches.

La complexité augmente depuis:
ExMM11a-SampleHold.pd
jusqu’à:
ExMM11h-SampleHold.pd

Many examples are in the form of
a folder containing several patches.

The complexity increases from:
ExMM11a-SampleHold.pd
until:
ExMM11h-SampleHold.pd
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Les exemples ExMM The examples

GEM

Dans cet exemple, les mêmes MiniModules

contrôlent le mouvement du son

et le mouvement l’image.

In this example, the same MiniModules

control the movement of sound and

the movement of image.
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Les exemples ExMM The examples

GEM

Dans cet exemple, le mouvement dans

l’image d’une camera est detecté

et contrôle la synthèse sonore.

In this example, the movement

in the image of a camera is detected

and control sound synthesis.
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Les exemples ExMM The examples

PDP

Dans cet exemple,

le mouvement dans

l’image d’une camera

est detecté et contrôle

la synthèse sonore.

In this example,

the movement

in the image of a camera

is detected and control

sound synthesis.
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Les exemples ExMM The examples

PDP

Dans cet exemple,

le déroulement d’un film est contrôlé.

In this example,

the sequence of a film is controlled.



Liens /Links

Wikipedia/PureData (français)   Wikipedia/PureData (english)
Miller Puckette site (Pd Vanilla installer...) http://www-crca.ucsd.edu/~msp/software.html
Pd-extended installer Pure Data Downloads & (if you like the risk) auto-build/latest/
puredata.info = puredata.org http://puredata.info/
3 tutorials in english 
  • The Theory and Technique of Electronic Music by Miller Puckette 
  • FLOSS Manual by Derek Holzer, Adam Hyde etc..
  • loadbang (Programming Electronic Music in Pd) by Johannes Kreidler 
2 apprentissages en français
  • Tutoriel Pure Data de Raphael Isdant 
  • PureData_Initiation_fr.pdf de Jérôme Abel 
1 tutorial en español
  • Manual Oficial 
1 tutorial em Português
  • TutorialPd.zip por Alexandre Porres 
2 tutorials on GEM in english 
  • Gem Manual by IOhannes m zmölnig 
  • GEM_Tutorial by Chris Clepper?
Mailing list Pd http://lists.puredata.info/listinfo/pd-list or http://www.mail-archive.com/pd-
list@iem.at/ (in english)
Mailing list GEM http://lists.puredata.info/listinfo/gem-dev or
http://markmail.org/browse/at.iem.gem-dev (in english)
Forum codelab http://codelab.fr/ (en français)
Forum~ Pure Data http://puredata.hurleur.com/ (in english)
Pdpedia http://wiki.puredata.info/
PureDataVideopedia http://www.youtube.com/profile_play_list?user=PureDataVideopedia 
A book + DVD bang bangbook.pdf free download (7.4M) (in english)
Tom Erbe UCSD class blog http://music.ucsd.edu/~tre/classblog.php
Centre de Ressources Art Sensitif (CRAS) http://www.craslab.org/ (formation Pd...)
Compagnie Prométhée http://www.ciepromethee.org/ et Naxos Bobine
http://www.naxosbobine.org/ (Formation Pd...)
Obiwannabe http://obiwannabe.co.uk/
idecibel http://artengine.ca/~idecibel/ (en français...n'existe plus)

Opinion

 

2000 Roland Cahen (français) Le billet d'humeur du maxeur...
2002 Miller Puckette (english) Max at Seventeen... 
2004 Miller Puckette Max, Pd... (english) Who owns our software? ... 
2006 Hans-Christoph Steiner (english) Pd as a programming platform 
2006 Max Mathews (english) "Max and Pd allow almost anyone to synthesize uninteresting
timbres..." Foreword 
2009 Johannes Kreidler (english) Programming Electronic Music in Pd (Abstract) 
2009 IOhannes m zmölnig Reflection in Pure Data.pdf and Slides 

http://en.wikipedia.org/wiki/Pure_data
http://fr.wikipedia.org/wiki/Pure_Data
http://www-crca.ucsd.edu/%7Emsp/software.html
http://puredata.info/downloads
http://autobuild.puredata.info/auto-build/latest/
http://puredata.info/
http://crca.ucsd.edu/%7Emsp/
http://www.xs4all.nl/%7Eadam/
http://www.umatic.nl/info_derek.html
http://www.pd-tutorial.com/
http://crca.ucsd.edu/%7Emsp/techniques/latest/
http://www.kreidler-net.de/
http://flossmanuals.net/puredata
http://raphael.isdant.free.fr/puredata.htm
http://raphael.isdant.free.fr/
http://abel.jerome.free.fr/
http://impala.utopia.free.fr/pd/
http://wiki.puredata.info/es/Manual_Oficial
http://sites.google.com/site/porres/
http://sites.google.com/site/porres/TutorialPd.zip
http://gem.iem.at/documentation/manual/manual
https://www.cs.tcd.ie/Nicholas.Ward/qm3/gem/index.html
http://gem.iem.at/author/zmoelnig
http://www.mail-archive.com/pd-list@iem.at/
http://lists.puredata.info/listinfo/pd-list
http://markmail.org/browse/at.iem.gem-dev
http://lists.puredata.info/listinfo/gem-dev
http://codelab.fr/
http://puredata.hurleur.com/
http://wiki.puredata.info/
http://www.youtube.com/profile_play_list?user=PureDataVideopedia
http://puredata.info/groups/pd-graz/label/book01/bangbook.pdf
http://puredata.info/groups/pd-graz/label/book01/
http://music.ucsd.edu/%7Etre/classblog.php
http://www.craslab.org/
http://www.naxosbobine.org/
http://www.ciepromethee.org/
http://obiwannabe.co.uk/
http://artengine.ca/%7Eidecibel/
http://perso.orange.fr/roland.cahen/Textes/Colloque-Max%20publication%2009.htm
http://crca.ucsd.edu/%7Emsp/Publications/dartmouth-reprint.pdf
http://crca.ucsd.edu/%7Emsp/Publications/isea-reprint.pdf
http://at.or.at/hans/research/pd/
http://crca.ucsd.edu/%7Emsp/techniques/latest/book-html/node5.html
http://www.pd-tutorial.com/english/index.html
http://lad.linuxaudio.org/events/2009_cdm/Saturday/18_Zmoelnig/18.pdf
http://lad.linuxaudio.org/events/2009_cdm/Saturday/18_Zmoelnig/zmoelnig_pdreflection.pdf

